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Why Do We Build Models/Simulations?

(Your answers)

When you have a working model and you are getting ready to present your project 
remember your answers to this question.  Does your project satisfy the reasons that 
you have given?  Are you expecting the judges to figure out what you have discovered 
from your model or are you explaining to them what you have learned from your 
model?
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Optimization and Models

Optimization is a formal way (among many others) for extracting information from a model.   
Used in this way it is not the main purpose for the project.  What type of information does it 
produce?

Optimization can also take a major role in the project in studying which optimization 
approaches work best.  In this role the project compares optimization approaches.

Past projects that used optimization:

2009-2010 3rd place team:  Los Alamos High School
To Kill a Flocking Bird (Peter Ahrens, Stephanie Djidjev, Vicky Wang, Mei Liu)

Applied brute force, bracketing, steepest descent and genetic optimization algorithms to 
a NetLogo model of flocking birds.

2010-2011 2nd Place Team: Los Alamos High School
BrilliAnts (Peter Ahrens, Dustin Tauxe, Stephanie Djidjev)

Investigated Ant Colony Optimizations
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Mirror, mirror on the wall....

Who is the fairest one of all?

Is the mirror performing an optimization?

How does the mirror define “fairest?”

What is the population for the optimization?
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Basic Definitions

• Optimization, or mathematical programming, is the study and practice of 
seeking, in a systematic way, the maximum or minimum values of a function (the 
objective function), and the values of the decision variables (the inputs to a given 
function) where the maximum or minimum objective function values are found. 
Complicating this in practice is that decision variables are often subject to 
constraints, and that the nature of the objective function may make analysis 
difficult.

• An algorithm is a step-by-step problem solving procedure. Algorithms can range 
from very simple (e.g. cooking recipes, driving directions between two locations 
on a map, the Sieve of Eratosthenes for enumerating prime numbers) to 
moderately complicated (e.g. Runge-Kutta methods of numerical integration) to 
very complicated (e.g. algorithms to maximize potential profits from oil-drilling 
activities).



Computational Solution Techniques in Mathematical Programming

Basic Definitions (cont.)

• The feasible region is the set of decision variable values which satisfy all of the 
constraints in a mathematical programming problem. Constraints define the 
limits of the feasible region.

• A maximum or minimum (the plural forms are maxima and minima), is a point 
in the feasible region where the value of the objective function can't be 
increased (for a maximum) or decreased (for a minimum) by moving in any 
direction in the local neighborhood. If this condition holds for the entire feasible 
region, then the point is a global maximum or global minimum.; otherwise, it's a 
local maximum or local minimum.

• Extremum (pl: extrema) can be used to refer to either a minimum or maximum.

• Optimum (pl: optima) is a minimum or maximum (usually global), as relevant to 
the stated problem. For example, if we're trying to minimize the objective 
function, then the optimum is the point at which the objective function is 
minimized.
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Basic Definitions (cont.)

• An exact algorithm is one which is mathematically guaranteed (under some 
stated conditions) to arrive at the solution to a particular type of problem. For 
some problems, there are known exact algorithms which are computationally 
very efficient; for others, all known exact algorithms are computationally 
expensive – prohibitively so, in some cases.

• NP-complete – computationally expensive usually requiring an exhaustive 
search of all possibilities. NP is nondeterministic polynomial time. NP-hard is 
similar complexity but without a formal proof.

• A heuristic algorithm is one which incorporates certain rules of thumb, or 
experience-based rules. It ignores whether the algorithm can be 
mathematically proven correct. In most cases heuristics require fewer 
mathematical and logical operations than exact algorithms – though there is 
no guarantee that the heuristic will arrive at the same solution.
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Optimization

• Sometimes more of an art than a mathematical science

• There is no “perfect” optimization method

• Powerful – worth $$$

• A 1% savings in operation costs can increase profit by 10%

• Used in nearly every business, engineering, science or professional field

• Many advances in the last decade (compare to most math disciplines with 
little change in 100 years)

This makes it great material for a SC Project
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First Step:  What is “Good”?

• Determine what you are optimizing - must be quantifiable

• Less fuel, less time, more widgets

• Often called an objective function, cost function, fitness function, or an 
evaluation function

• Evaluation functions should be written where the optimum is a 
maximum or a minimum

A minimum will be assumed for the rest of this presentation
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Second Step: What are the 
Independent Variables?

• One variable

• Two variables
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Example: Global vs. Local Extrema

• At which of the labeled X values does the graph reach its minimum and 
maximum Y values? These are the global minimum and global maximum (i.e. 
global extrema).

• Which of the labeled X values are local – but not global – extrema?

Consider the following graph. Assume that the decision space is represented by 
the X values (limited to the visible width of the graph), and that the objective 
function values are the Y values.
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Considerations

• Methods work best with smooth functions

• Independent variables should not themselves be correlated. If they 
are, as they often are, the optimum values of the independent 
variables may be wildly off. Yet the minimum of the objective function 
will be reasonable.

• There is no guarantee in most of the methods of a global minimum, 
just a local minimum
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Tricks

• Isolate independent variables and solve

• Similar to technique in “Clue”®

• Example – Objective function is highest 
level of ant activity. Independent variables 
are hours of daylight and temperature.

• Take data at same temperature but on 
different length days
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What is a Good Method?

• Method should evaluate the function as few times as possible or 
fewest number of steps/guesses

• Parallel methods can work better with more guesses at each step 
rather than the least number of evaluations. For parallel methods we 
should redefine steps to consist of one or more guesses or function 
evaluations

• A good method for one problem is not necessarily a good method for 
another problem

• Robustness (i.e. working for all cases) can be more important than 
efficiency or fewest steps
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Types of Problems

• Linear – treated in Operations Research, Business Schools. A function example is 
22 lbs of plastic per 100 widgets produced. (Note: Operations Research also 
delves into most of the following types of problems also.)

• Non-linear – occurs more often in science where inter- relationships between 
variables are more complex. A small change in an independent variable can 
generate large changes in the objective function.

• Complex problems (or NP-complete) – a solution 
can be verified, but there is no known efficient way 
to locate a solution. Examples are the traveling 
salesman problem or the knapsack problem. While 
an optimum solution cannot be easily computed, a 
near-optimal solution (good enough solution) can be 
found. Computing a “perfect” chess move is a good 
example of this type of problem.
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Simple Mathematical Optimization

• Optimum must be at a point where the slope is zero. In math this is expressed 
as when the derivative is zero. This point is a local minimum. However, it 
doesn't necessarily follow that any such zero-slope point is a global optimum 
for the function.

• The points where the slope is zero are the set of candidate points. Some 
adjustments must be made

• Points that violate the constraints must be discarded (such as negative values that violate physical 
reality)

• Add to the set of points the intersections of the optimization surface and the constraints.

• We now examine this set to see which are global extrema, and which of those 
is a minimum extrema.
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Example: Maximize Fenced-in Area

• You have enough material for 100' of fence.

• For simplicity, you've decided to make the pen rectangular in shape.

• For economy, you're going to use the cliff wall as one side of the 
rectangle; you don't need to put fencing material on that side.

Imagine that you own a piece of land, located at the bottom of a cliff. You 
intend to fence in a portion of this land, as a pen for animals.

Your task is to find the dimensions for the fenced-in area that maximize the 
area enclosed, using only the materials you have.

• What mathematical function describes the area enclosed by the fence, 
in terms of its dimensions?

• Are there any constraints on the dimensions? What are they?
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Example: Maximize Fenced-in Area (cont.)
We can draw a simple diagram of the problem, as follows:

Our task is to find the value of x that gives the 
largest value for f(x). We recognize f(x) as a 
quadratic of the form f(x) = ax2 + bx + c. From 
intermediate algebra, we remember that the vertex 
of the parabola described by the quadratic is found 
where x = b/2a.

In this case, b = 100, and a = 2. Computing x and 
the resulting area, we get the maximum area (1250 
ft2), when the dimensions are 25' X 50'.
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Three Main Approaches
• Direct solution – used for linear, quadratic and other simpler problems where 

simple analytic approaches are workable.

• Simplex Method or Linear Programming are typical solution techniques. Also Lemke's algorithm for 
quadratic programming, the stepping-stone algorithm for the transportation problem, the Hungarian 
method for the assignment problem, and Dijkstra's algorithm for finding the shortest path on a network

• Iterative solution methods – take slight perturbations of the initial guess and 
search in the direction with the better value.

• Steepest Descent and Conjugate Gradient solvers are examples of methods to solve these 
problems

• Directed random search methods – search algorithms have randomness as a 
key element, where the sampling distributions are influenced by the objective 
function, and where the amount of randomness tends to decrease as the number 
of iterations increase.

• Simulated Annealing, Genetic Algorithms (GA), Ant Colony optimization, and Particle Swarm 
Optimization are some of the methods most suitable for this class of problems.
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Direct Methods
Linear Programming via the Simplex Method

• Set up the problem as a system of linear equations, with more variables than 
equations (new variables are added as needed, to turn inequalities into equations).

• By a series of matrix “pivoting” operations, move from one feasible solution to 
another, where each successive solution improves the objective function.

• When the objective function cannot be improved further, we've found the optimum.

When the objective function is linear, all the constraints are linear, and the decision 
variables are continuous, we have a linear programming problem (LP). In 1947, 
George Dantzig invented the simplex method to solve linear programming problems. 
In very general terms, this algorithm proceeds as follows:

This process is as a series of moves from vertex to vertex, along the edges of an n-
dimensional convex polytope, with each move improving the objective function. When 
none of the edges lead in a direction that improves the objective function, we've found 
the optimal solution.
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Exercise: Maximize Profit on Exports1

A firm exports two types of machines: P and Q. Type P occupies 2m3 of space, 
and type Q requires 4m3. The mass of type P is 9kg; type Q masses 6kg. The total 
available shipping space is 1,600m3 and the total mass of the machines cannot 
exceed 3,600kg. The profit on type P is $100 and the profit on type Q is $80. How 
many of each machine must be exported to maximize profit, and what is that 
maximum profit?

Here's the LP formulation, along with a graphical view of the feasible region (i.e. 
the region containing all points satisfying the constraints):
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Exercise: Maximize Profit on Exports (cont.)
We could easily solve this example by computing the profit at all four vertices of the 
feasible region and selecting the vertex with the highest profit. The advantage of the 
simplex method is that it almost never needs to visit each vertex; it always moves along 
the edge that improves the objective function most. This is a big advantage when 
problems are much larger than this one.

There are many libraries that implement the simplex method. For this example, we'll 
use Apache Commons Math (http://commons.apache.org/math), an open source Java 
library.

1. In NetBeans, open the SimplexExample project.
2. Open the SimplexExample.java file from the org.nm.challenge.optimization 

source package.
3. Complete the code by following the instructions that begin on line 72 of 

SimplexExample.java (hint: review the constants declared in lines 42-48).
4. Compile and run the program. What's the result?
5. Is the answer integral? If not, how should we interpret it?
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Exercise: Giapetto's Woodcarving
Giapetto's Woodcarving Inc. manufactures two types of wooden toys: soldiers 
and trains. A soldier sells for $27 and uses $10 worth of raw materials. Each soldier 
that is manufactured increases Giapetto's variable labor and overhead costs by 
$14. A train sells for $21 and uses $9 worth of raw materials. Each train built 
increases Giapetto's variable labor and overhead costs by $10. The manufacture of 
wooden soldiers and trains requires two types of skilled labor: carpentry and 
finishing. A soldier requires 2 hours of finishing labor and 1 hour of carpentry labor. 
A train requires 1 hour of finishing and 1 hour of carpentry labor. Each week, 
Giapetto can obtain all the needed raw material but only 100 finishing hours and 80 
carpentry hours. Demand for trains is unlimited, but at most 40 soldier are bought 
each week. Giapetto wants to maximize weekly profits (revenues – costs).

Operations Research: Applications and Algorithms, 4th Edition, by Wayne L. 
Winston (Thomson, 2004).

More detail on this problem at:
http://www.ibm.com/developerworks/linux/library/l-glpk1/
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Exercise: Giapetto's Woodcarving

• There are two types of wooden toys: soldiers and trains.

• A soldier sells for $27, uses $10 worth of raw materials, and increases variable 
labor and overhead costs by $14.

• A train sells for $21, uses $9 worth of raw materials, and increases variable labor 
and overhead costs by $10.

• A soldier requires 2 hours of finishing labor and 1 hour of carpentry labor.

To summarize the important information and assumptions about this problem:

The goal is to find the numbers of soldiers and trains that will maximize the weekly profit.

• A train requires 1 hour of finishing labor and 1 hour of 
carpentry labor.

• At most, 100 finishing hours and 80 carpentry hours are 
available weekly.

• The weekly demand for trains is unlimited, while, at 
most, 40 soldiers will be sold.
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Exercise: Giapetto's Woodcarving
1. Install libgplk0, libglpk-dev, glpk-utils, glpk

2. Copy the file giapetto.mod from the giapettoLP directory

3. glpsol -m giapetto.mod -o giapetto.sol
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Interior Point Solution Techniques
While the simplex method and its variants are usually very good, and they're 
widely used, there are extreme instances where the simplex method gives close to 
worst-case performance. The first practical alternative to the simplex method for 
these problems was Karmarkar's algorithm, invented in 1984.

Karmarkar's algorithm can be viewed as moving through the interior of the 
polytope, in a relatively small number of steps. For this reason, we refer to this and 
similar methods as interior point methods.

The computational cost of formulating LPs for interior point methods, and of 
computing each step through the interior of the polytope, are very high, but the 
number of iterations required for solution is low. This trade-off makes these 
techniques well suited to certain types of very large problems, but poorly suited to 
most others.
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One-dimensional Methods:
Bracket methods

• For single variable cases with unimodal objective function (no local minima)

• Take 3 starting points widely separated. The middle point, b, must be lower 
than the other two. Then take a point in between a-b or b-c. Suppose we take 
a point in b-c called d. If d > b, then the new bracket triplet is a < b < d, else, 
the new triplet is b < d < c.

• The various methods use different ways to 
estimate the best point to take for the next 
guess. Golden mean method uses the 
golden ratio. Other methods use a 
parabolic function or first derivatives.
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Exercise 1 – Bracket Method

1. Install libgsl0ldbl, libgsl0-dev

2. Open up Eclipse. Select New Project, New C Project, Executable:Empty Project. Put 
in name of project – Bracket. Click through rest of windows.

3. Right click on Bracket in Project Explorer. Select new: C Source file. Name it 
bracket.c. Enter source from BracketExample/bracket.c or http://www.gnu.org/
software/gsl/manual/html_node/Minimization-Examples.html

4. Right click on Bracket again and select Properties all the way down at the bottom. 
Open up C/C++ Build and select settings. Select GCC C Linker:Libraries. Add the 
libraries gsl and then gslcblas. Compile project.

5. Select Run menu: Run configurations. Click on add (small page with plus sign at 
upper left). Setup run configuration and run problem.

6. See the Appendix for platform specific instructions.

Find the minimum of f(x) = cos(x) + 1, which occurs at x = ∏. The starting interval is 
(0,6), with an initial guess for the minimum of 2.

Try the other minimization algorithms in the library, golden section and quad golden. The 
reference page is http://www.gnu.org/software/gsl/manual/html_node/Minimization-
Algorithms.html. The function names are gsl_min_fminimizer_goldensection and 
gsl_min_fminimizer_quad_golden. Which works best for this problem?



Exercise 2 – Bracket Method

Take your favorite Netlogo model. Let's say that it is a fire egress model. For one 
slider, optimize the number of people that escape. Note that at each input value, you 
will have to take a statistical average of the result because of the random number 
used in the simulation.



Line Search Methods with Derivatives

• Two points uniquely determine a line.  Where is the minimum of a line?

• Two points and a derivative (slope) at the first point determine a parabola.  There is a 
unique minimum or maximum to a parabola.  Where is this minimum or maximum?

• Two points and derivatives at both points determine a cubic spline.

• How are some ways that one can get a polynomial of order greater than one without 
using derivatives?
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Multivariable Methods
Rosenbrock Test Case

If you have a Mac, open Grapher (Applications -> Utilities -> Grapher).  Create a 3-
D plot.  Enter the equation:

Go to Format -> Axes & Frame.  Set the following:

•Abscissa: [-2, 2]
•Ordinate: [-2, 2]
•Height: [0, 2500]

Right click on the plot and edit the appearance.  
Change Checkerboard to Height.  If the plot 
appears jagged as you play with it then you might 
want to increase the resolution and reload.

The minimum of this function is at (1,1).

z = (1-x)2 + 100(y-x2)2
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Multivariable Methods:
Steepest Descent

1. Multivariable case starts by choosing a direction.  A 
common choice is the steepest descent.

2. Use a one-dimensional line search to decide how far to 
go in this direction.  Do we need to find an optimum 
for the one-dimensional line search?

3. Select a new steepest descent direction and repeat the 
line search.  Iterate.

See Numerical Recipes for description, method and 
sample code.
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Multivariable Methods
Conjugate Gradient

• Trick here is to take the conjugate 
to all previous search directions to 
try and force solution "down the 
valley"

• Why are valleys important? Usually 
one independent variable is 
stronger than the other, producing 
a long valley
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Multivariable Methods
Rosenbrock Test Case

Shown here is the steepest 
descent algorithm applied to the 
Rosenbrock problem. The narrow 
curved valley causes the method to 
take a lot of steps. The conjugate 
gradient approach was developed 
to work better on this type of 
problem. (From wikipedia)

ORNL has pictures of various 
optimization methods applied to the 
Rosenbrock and Beale functions: 
http://www.phy.ornl.gov/csep/mo/
node17.html
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Multivariable example

• Function: z = 10(x1)2+(y2)2+30

• Gradient is [20(x-1), 2(y-2)]T

• Optimum step size ∝ can be calculated analytically.  For any 
practical problem a line search method will need to be used.



Computational Solution Techniques in Mathematical Programming

Graph the results (Mac Only)

• Graph the function by going to 
Applications>Utilities>Grapher

• select 3D Graph and White and 
enter the equation:

z = 10(x1)2+(y2)2+30

• Then go to Format>Axes and 
Frame and select Height Axis and 
make it go from 0 to 700.

• Type in your points from one of the methods in the following slides or create a text 
file with your points to import. Separate the numbers with "," and rows with ";" with 
all the points on one line with no spaces. Go to grapher and click on "+" and New 
Point Set and Edit Points, then import your *.txt file.
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Steepest Descent

• Edit steep.c and set x[0] and x[1] to your initial guess.

• Compile with gcc -o steep steep.c fandg.c

• Run with ./steep

This example uses the analytical step size. 

Choose initial guess x

Evaluate f(x)

Evaluate s = -∇f(x)

Find ∝ to minimize f(x + ∝s)

x = x + ∝s
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Polak-Riviere Nonlinear Conjugate Gradient

• Edit polriv.c and set x[0] and x[1] to your initial guess.

• Compile with gcc -o polriv polriv.c cubsrch.c fandg.c

• Run using ./polriv

This example uses a cubic line search to find the step size.
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Multivariable Methods:
A NetLogo Approach

1. Define an objective function f.

2. Place all the sliders in the middle of their ranges

3. Either fix random number generators at the middle or use averages of 
several runs.

4. Figure out which inputs are the most important by moving one slider and 
computing (f(x2) -f(x1))/(x2 - x1) where x represents the current slider input 
while the other inputs are held constant.  Repeat for all inputs.  The larger 
absolute numbers are the most important inputs at this point.  Choose a 
direction (e.g. move the most important slider two units, the next one unit, 
etc.).

5. Do a line search in the chosen direction.

6. Go to step 4 and compute new differences and repeat the process until you 
find a rough optimum input.

7. What inputs are the most important for your model?  What does the rough 
optimum input tell you about your model?
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Multivariable Methods:
A NetLogo Approach (cont.)

• Choose the slider that makes the biggest difference.

• Adjust it until you have an optimum.

• Choose the slider that makes the next biggest difference (direction is orthogonal to 
the first).

• Adjust it until you have an optimum.

• Repeat until you have gone through all the sliders, then start again from the slider that 
makes the biggest difference.

So simplifying this to an extreme:
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Directed Random Search Methods
• Best where optimization surface is complex or 

has local minima

• Has some randomness in the solution 
technique

• Think of method you use for “Battleship”®

• Heuristic based methods work better than 
exact algorithms

• Examples of Solution Methods

• Simulated Annealing

• Genetic Algorithms

• Ant Colony Optimization

• Particle Swarm Optimization
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The Traveling Salesman Problem
One example of this is the traveling salesman problem (TSP):

Given n cities (points), with a distance dij between cities i and j,
find the route through all the cities that minimizes the total distance, and returns to the 
starting point. Exact solution techniques are very expensive once the number of cities 
moves into the thousands (not that uncommon, when we start seeing such parallels as 
those between points on a circuit board and cities on a map) and may be years of CPU 
time.

One of the best heuristics for the TSP is the Lin-Kernighan algorithm, introduced in 
1973. This algorithm works by adaptively swapping pairs of tour fragments to formulate 
an improved tour at each step.
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Simulated Annealing
In simulated annealing (which refers to the analogy with how metals cool and 
anneal), the solution method is allowed to sometimes take an upward step rather 
than always going in the downward direction. This can be helpful in avoiding local 
minima and stepping “over the hump” to the global minimum. The frequency of the 
upward step is always an heuristic algorithm which must be developed for the 
problem at hand.
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Exercise - Simulated Annealing

• Open up Eclipse. Select New Project, New C Project, Executable:Empty 
Project. Put in name of project – Traveling_Salesman_Problem. Click through 
rest of windows.

• Right click on Traveling_Salesman_Problem in Project Explorer. Select new: 
C Source file. Name it siman_tsp.c. Enter source from 
TravelingSalesmanProblem/siman_tsp.c or search the web for siman/
siman_tsp.c.

• Right click on Traveling_Salesman_Problem again and select Properties all 
the way down at the bottom. Open up C/C++ Build and select settings. Select 
GCC C Linker:Libraries. Add the libraries gsl and then gslcblas. Compile 
project.

• Select Run menu: Run configurations. Click on add (small page with plus sign 
at upper left). Setup run configuration and run problem.

• To plot results, run “sh plot.sh” or “sh plotgif.sh”. Look at the files *.eps or *.gif.

Traveling Salesman Problem
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Traveling Salesman Problem Results
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Particle Swarm Optimization

• For particle swarm optimization, each particle is given a position and velocity. 
Then an acceleration is applied to each particle towards its “personal best” and 
towards the “global best”. The further away from these locations, the stronger 
the acceleration towards them. A random factor is also applied to the 
acceleration forces.

• Exercise – Start up Netlogo 
4.1.3. Open up the models 
library and go to Sample 
Models:Computer 
Science:Particle Swarm 
Optimization (Uri Wilensky, 
Northwestern University). 
Setup and run.

Description: http://ccl.northwestern.edu/netlogo/models/ParticleSwarmOptimization
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Genetic Algorithms

• Each member of the population is evaluated to assess its fitness

• A subset of the population is chosen to survive to the next generation. This 
selection is random, but individuals with better fitness are more likely to be 
selected.

• To replace individuals that don't survive, a subset of the population is chosen 
(randomly again, but again weighted to the most fit) to reproduce.

• The next generation is produced by combining the genomes from pairs of 
individuals selected for reproduction.

• Optionally, an offspring's genomes may be mutated slightly in a random fashion.

A genetic algorithm (GA) is a heuristic that emulates some of the mechanisms of 
evolution to find a good enough solution to a problem. A GA starts with a population of 
randomly-generated solutions to a problem; each of these is encoded as the genome 
of an individual member of the population. Then, we follow these steps to produce 
successive generations of the population:
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Exercise: TSP with a Genetic Algorithm
Start up netlogo, v5.0.4. Open the models library and under Computer Science 
select Robby the Robot (Melanie Mitchell, Complexity: A Guided Tour).

Robby the robot picks up cans.  He can only see the current square and his four neighbors 
(wall, can or neither).  The optimization chooses a strategy for each of the 3^5 = 243 
possibilities.

Read the info tab and describe the objective function.

Run the optimization.  Stop every 100 or so iterations and view Robby’s environment and 
step through the best strategy.  How does this look over time?

Look at the best fitness graph.  Does it plateau at times?  How do you think changing the 
mutation rate (lower or higher) would change these plateaus?  Do you think it would 
speed up convergence?  Do you think it would have a better chance of finding a better 
strategy?
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Convex Hull Construction Heuristic for TSP
One relatively intuitive and effective approach to the TSP begins by finding the subset 
of points, and the tour connecting them, such that all of the points are either in the 
subset, or in the interior of the polygon formed by the tour. This polygon is called the 
convex hull of the full set of points. (The concept of the convex hull can be applied to 
n-dimensional polytopes, but the application to the TSP is primarily of use in two 
dimensions only.)

Once we have this initial subset and tour (collectively called a sub-tour), we add to it 
progressively, incorporating an additional point at each step. One reasonable heuristic 
is to select at each step the point that results in the smallest immediate increase in the 
length of the sub-tour; this type of heuristic is referred to as “greedy”, since decisions 
are based only on the cost/benefit of immediately available alternatives.

When all points in the set are incorporated into the sub-tour, the
algorithm is done.
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Exercise: TSP w/ Convex Hull & 
Greedy Insertion

Go to the site

http://www-e.uni-magdeburg.de/mertens/TSP/node2.html

Try running the second applet. Select a large number of nodes (25) to get a better 
idea of how the algorithm performs. Then select run. Select solve to see how it 
compares to the best solution.
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Appendix
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Linux setup (64 bit Ubuntu)
• Netlogo

• Run the Netlogo installer

• Eclipse for C programs

• Install Eclipse by running the eclipse-cpp-galileo-SR1-linux-gtk-x86_64 
installer

• Install Java by running the jdk-6u16-nb-6_7_1-linux-ml.sh installer
• Install compilers and supporting tools with the package manager

• build-essential
• Install libraries and gnu software with the package manager

• libgsl0ldbl and libgsl0-dev
• glpk-utils
• plotutils

• When setting up the compiling in Eclipse
• Add to GCC C Linker:Libraries

• gsl
• gslcblas

• Netbeans for Java programs
• Run the netbeans installer
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Windows Setup
• Netlogo

• Run the Netlogo installer

• Eclipse for C programs
• Install Wascana by running the Wascana installer (http://code.google.com/a/eclipselabs.org/p/

wascana/ - download wascana-1.0-setup.exe)
• Install libraries and gnu software by running gnu installers (http://ascend4.org/

Binary_installer_for_GSL-1.13_on_MinGW) for
• gsl-1.13

• Add to system path by opening up control panel, search for system environment and adding to the 
end of the path

• ;C:\Program Files (x86)\GnuWin32\bin;C:\Program Files (x86)\Wascana\mingw\bin
• When setting up the compiling in Eclipse

• Add to GCC C Compiler:Directories
• "C:\Program Files (x86)\GnuWin32\include"

• Add to GCC C Compiler:Symbols
• GSL_DLL

• Add to MinGW C Linker:Libraries
• Libraries

• gsl
• gslcblas

• Library search path
• "C:\Program Files (x86)\GnuWin32\lib"

• Netbeans for Java programs
• Run the netbeans installer
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OSX (Mac)
• Netlogo

• Place NetLogo in the Applications directory. Double click on the NetLogo icon.

• NetBeans

• Run the NetBeans installer

• C/C++ Code

• Install Xcode development tools. These should be on your OS disk or 
register and download at http://developer.apple.com/technology/
xcode.html.  More recent Macs can install Xcode from the App store.

• Install MacPorts (choose the version for your OS): http://
www.macports.org/install.php If necessary update using sudo port d 
selfupdate

• Make the following directory and cd to it: /opt/local/bin/portslocation/
dports/gsl

• Then install the Gnu Scientific Library (sudo port install gsl)
• Running from the command line

• Copy SurfaceMin.c and myfunction.c to a directory. Then type the 
following: gcc o multimin SurfaceMin.c myfunction.c Wall I/opt/
local/include L/opt/local/lib lgsl lgslcblas

• To run the program ./multimin
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OSX (Mac) (cont)

1. Open XCode (/Developer/Applications/ and drag Xcode.app to your 
Dashboard.)

2. Then open File/New Project...
3. In the "New Project" Assistant, expand the "Command Line Utility" group.
4. Select "Standard Tool"
5. Click "Next"
6. Give a project name (MultiMin) and directory, then click "Finish".
7. Press CmdShiftR to open the Console window. Output will appear there.

To run the program in the Xcode IDE:

Project>Add to Project and add SurfaceMin.c and myfunction.c. Delete main.c.

Edit Project>Edit Project Settings
Under Search Paths:

Add to User Header Search Paths   /opt/local/include
Add to Library Search Paths            /opt/local/lib/

Under Linking:
Add to Other Linker Flags:               -lgsl -lgslcblas

Set the Architecture to Native Architecture
Click the "Build and Go" toolbar button.


